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Introduction 
Welcome to the Timestone Software Chroma Key Module! 

This user guide provides a simple, quick and easy guide to keying your green and blue screen images 
and replacing their background with a new one.  

If you have used other chroma key software you will more than likely be able to “jump right in”. On 
the other hand if this is your first venture into the world of “Green Screen” this manual will help you 
become familiar with the concepts and tools of a chroma key workflow . 

The workflow for the Chroma Key Module can essentially be divided into two parts: 

• Keying the images (removing the background – usually green or blue) 

• Placing a new background 

This quick start guide also assumes the user is somewhat familiar with the other Timestone Software 
applications and is already comfortable with such concepts as template design, labeled images, 
importing a text file and data entry. 

About the Chroma Key Module 

The Timestone Software Chroma Key module is not a stand-alone application. It is an optional utility 
used in conjunction with any Timestone Software applications capable of image editing.  

For programs running on the License Server a special chroma key license is required. Applications 
requiring a USB hardlock will need a chroma key enabled hardlock in place of the regular USB 
hardlock. 
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Keying the images 
The process of removing the background from an image, thereby making the background 
transparent, is called “keying”.  The background can be any color but generally is either a blue or 
green screen. For the purposes of this document we will assume the background is a green screen and 
will therefore refer to such terms as “green screen” and “green spill” 

What makes a good green screen image? 

The art of green screen photography is beyond the scope of this User Guide. Briefly the background 
should be lit with soft, even, shadow-less lighting and the subject well removed from the background 
to minimize the possibility of spill (green colored light reflecting off the background onto the subject.) 

The process of keying an image is far simpler with good, clean images devoid of spill. Moreover the 
prospect of applying the result to bulk images in an automated workflow is greatly enhanced. 

The Chroma Key tools 

The Chroma Key tools are available either as menu items from the Chroma Key menu item or from 
the Chroma Key Toolbar. Many tools are also available as keyboard shortcuts. 

Whether the toolbar is hidden or displayed can be set as a program default. (When not using the 
software for keying images you may prefer to hide the toolbar.) 

To display or hide the Chroma Key Toolbar go to File>Options>Image Correct and check or uncheck 
the “Use Chroma Key” option as needed. Note the selection only takes effect when the program is 
re-started. 

The Chroma Key toolbar 

All the tools needed to successfully key your images are available from the Chroma Key toolbar. 
Many tools are also accessible with keyboard shortcuts.  

 

The tools are grouped into sets according to their function. We shall look at each tool in more detail as 
needed. 
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Activating the Chroma Key toolbar 

The tools in the Chroma Key toolbar are accessible after clicking the “Chroma Key Image Tool” 
from the main toolbar.  

 

In the above screen grab, clicking the Chroma Key Image Tool button will take the images out of 
cropping mode and into Chroma Key mode. 

The different views 

The first set of tools are not really tools but buttons to toggle your view of the images between four 
different states. It is important to realize the images when in Chroma Key mode.  
 

 

The current view is designated by a blue rectangle around the icon. For example in the screen grab 
above, the current view is the Unkeyed Image view. 

 

 

 

 

 

 

View Matte 

View Image on Background 

View Keyed Image 

View Unkeyed Image 
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View Unkeyed Image 

In this view the images appear as imported and the original background is always visible even after 
the images have been keyed. 

 

 

 

To quickly toggle to the Unkeyed Image view from any other view right click with the mouse 
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View Matte 

Once an image has been keyed or partially keyed a matte is generated. The matte can be viewed in the 
View Matte mode.  

The matte is essentially a monochrome mask in which pure black pixels are completely transparent 
while pure white pixels are completely opaque. Grey pixels are partially transparent. 

The matte is an important element in keying the images. The matte view is used when cleaning the 
background and foreground and its use will be discussed later. 

 

To quickly toggle to the Matte View from any other view Ctrl-Right click with the mouse 
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View keyed image 

The View Keyed image mode shows the image as keyed (or partially keyed if the process has not been 
completed) on a transparent background. 

 

 

To quickly toggle to the Keyed Image view from any other view Ctrl-Shift-Right click with the mouse



Timestone Software Chroma Key Module 

The Chroma Key Tools and Views  
 

8

View keyed image on background 

Once the image has been keyed and a background set, this view will display the image on the new 
background. 

 
 

To quickly toggle to the Keyed Image on Background view from any other view Shift-Right click with 
the mouse.
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Keying the images 
In simple terms the process of keying the images can be subdivided into three steps 

1. Selecting the background color 

2. Cleaning the background and foreground 

3. Dealing with spill 

We shall look at these steps in more detail as we work through an example of keying an image. 

Step 1: Selecting the background color 

The first step involves selecting the background. This will also “knock out” most of the background. 

1. Select an image or set of images 

2. Change the view to either of the two keyed image views 

3. Click on the Select Background Color tool 

4. Click in the background area 

5. Release the mouse, most of the background will be removed 

 

 

With the Select Background Color 
tool, click inside background area. 
Be sure to avoid sampling too close 
to the edges. 
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The result after selecting the background 
color. 

Note the background is now transparent; 
however the foreground is also partially 
transparent. 

Both the foreground and the background 
will be “cleaned up” in the next step. 
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Step 2: Cleaning the background and foreground 

The first step selects the background color as the transparency and in doing so generates the matte. 
To view the matte, click the View Matte button. 

 

 

Zoom and pan 

To help work with specific areas of the image or matte, zoom and pan tools are available. 

• To zoom in, roll the mouse wheel toward you 

• To zoom out, roll the mouse wheel away from you 

• To quickly return to the original un-zoomed view, Alt-double click the image or matte 

• To pan a zoomed view, hold the Alt key together with the left mouse button while 
dragging the mouse 

 

The initial matte reflects the result 
obtained in our first step.  

The background is predominately black 
indicating these areas of our image will 
become transparent. Note the presence of 
some dark grey pixels in the lower left 
portion of the matte. 

The foreground has some white (opaque) 
areas but also several grey areas which 
have resulted in the foreground being 
partially transparent. 

To “clean” these areas we use the Clean 
Background and Clean Foreground 
tools.  

Note these tools (in fact, all tools) can be 
used in any view, not just matte view, 
however the matte view makes it easier to 
see the results of the Clean Background 
and Clean Foreground tools 
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An important note about the zoom and pan tools 

The zoom and pan tools do not crop or pan the images as in the “normal” modes of the software. In 
Chroma Key Mode the tools are simply used to assist with working with particular areas of the 
image. 

 

Cleaning the background 

Examine the matte for background areas that are not totally black. In the example above there is a 
grey area in the lower left corner.  This will be cleaned with the Clean Background tool 

1. Select the Clean Background tool 

2. If necessary use the zoom and pan tools to help locate and clean any grey pixels.  

3. Drag the mouse through any background grey pixels. Avoid sampling too close to the 
foreground edge 

4. Use the zoom and pan tools to help locate and clean as necessary 

 

 

Unless the green screen has been 
perfectly, evenly lit during photography, 
some variation in the background 
exposure is inevitable. 

Use the Clean background tool to “clean” 
areas that are not totally black. Be certain 
not to sample too close to the foreground 
edge 
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Using undo, re-do and reset 

If at any point an incorrect area has been sampled or an error made for whatever reason, it is possible 
to use the undo feature to go back one step at a time. A reset function is also available to return the 
image to the original, unkeyed state. 

• Use Ctrl-Z to undo one step at a time 

• Use  Shift-Ctrl-Z to redo one step at a time 

• To reset an image back to its original unkeyed state use the reset button on the Chroma 
Key toolbar 

 

 

 

 

 

 

The result of trying to sample too close to 
the edge. Notice some areas of the 
foreground have now been clipped. 

Use the Undo feature to go back and re-
sample elsewhere. If needed, it is possible 
to reset the image and start from the 
beginning with the reset tool. 
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Cleaning the foreground 

Once the background has been cleaned and all pixels made transparent, it will be necessary to clean 
the foreground. 

 

 

1. Select the Clean Foreground tool 

2. Click and drag the mouse through foreground areas of the matte that are not completely 
white. Avoid sampling too close to the edges 

3. If necessary use the zoom and pan tools to help locate grey foreground pixels that should be 
opaque 

4. It is not necessary to clean every single pixel. Leaving a few grey pixels will not be noticed in 
the final result. In fact attempting to clean every single pixel may result in jagged edges on the 
foreground 

In most cases the foreground will require 
more cleaning than the background. 

In our example notice the several 
foreground areas of the matte that are not 
opaque. These areas are cleaned with the 
Clean Foreground tool. 

When cleaning the foreground it is even 
more important to not to try and get the 
matte too perfect by sampling too close to 
the edges as this may result in clipping of 
important foreground areas. 

This is especially relevant when dealing 
with areas such as the hairline where 
background spill may be present. The 
Chroma Key Module has various spill 
removal tools for this purpose which will 
be discussed later 
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Use the Clean Foreground tool to make 
opaque any areas of the foreground that 
do not appear completely white in the 
matte view. 

The zoom and pan tools are useful to 
clean small areas. 

Be careful to not sample too close to the 
background edge as this may result in 
loss of fine detail such as hair. 

The finished matte should predominately 
contain pure black (transparent) and pure 
white (opaque) areas. 

The only “grey” or semi transparent areas 
in our example are loose, translucent 
strands of hair. These areas contain 
“transparency spill” which will be 
discussed later.  

Attempting to opaque these areas will 
result in losing fine detail. Instead we will 
remove the spill from the loose strands of 
her in the next step 
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Step 3: Spill replacement 

Nearly all green screen images will suffer from spill in varying degrees. The final step in chroma 
keying green screen images involves removing (or replacing) the spill.  

What is spill and how does it occur? 

Spill occurs when reflected light from the background is visible on the foreground subject. To a large 
extent spill can be avoided or at least minimized during photography however since this is not always 
possible and number of tools are therefore available to deal with the occurrence of spill. 

Solid spill versus transparency spill 

Somewhat arbitrarily spill can be classified as either “solid spill” or “transparency spill”.  

Solid spill is most easily avoided during photography and results when light reflects off the green 
background and is intense enough to rim light the subject with colored light. In some cases the spill 
may be severe enough to appear on the subjects face, especially the cheeks and nose. The best way to 
deal with solid spill is to avoid it and this can often be achieved by simply reducing the exposure of 
the background and/or moving the subject further away for the background. 

 

 

An example of solid spill.  

The background is over-exposed and 
reflected green light is visible on the 
subject’s cheek. 
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Transparency spill on the other hand is less easily avoided during photography and is most often seen 
in the edges of blonde or fair hair especially with loose or stray hair. Given that such hair is 
translucent in nature it is inevitable that some background color will be visible in such areas. 

 

 
 
Why is it called spill replacement and not spill removal? 

When working with spill it is tempting to think of the spill as being removed from the image. In fact 
what is happening is the spill color is replaced with another color.  

By default the replacement color is the complement of the background color. In green screen 
photography the spill color will of course be green tones and are therefore replaced with red tones.  

The user has the option to change the replacement method from the complement color to either a 
solid color or a defocused copy of the background color. These options will be discussed later 

An example of transparency spill.  

In portrait photography such spill is most 
often seen in loose hair especially for fair 
hair types.  

Such spill is less easily avoided in 
photography and is therefore the most 
common type of spill encountered. 
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The spill replacement tools 

The Chroma Key Module offers three separate spill replacement tools each working in a slightly 
different way and with different degrees of sensitivity. It is not necessary to use all the tools for a given 
image - usually only one tool is all that is required.  

When working with spill it is important to realize you are working with color regions in an image 
rather than a precise physical location. Cleaning a light blonde area of hair for example will also affect 
any other similar color tones with spill. 

The spill sponge 

The spill sponge is possibly the quickest and simplest tool to use however it is also the “coarser” of the 
three tools and therefore may be unsuitable for certain images where are more subtle approach is 
needed. 

To use the spill sponge: 

1. Select the spill sponge tool from the Chroma Key toolbar 

2. Change to one of the two Keyed Image views if not already there 

3. Click in each of the areas of the image with spill. For example clicking in a dark blonde area 
with spill will clean any other dark blonde areas with spill 

4. It may be useful to zoom into the problem areas to be able to click with greater accuracy 

 

 

. 

The fine tune sliders 

The spill sponge, being a coarser tool, may not be appropriate for most images. It is possible the spill 
sponge will only replace spill up to a certain point and not replace all spill. Conversely the spill 
sponge may be too aggressive and replace too much color. For both of these reasons the Fine Tune 
sliders or the Spill Minus tool may give a superior result. 

The Fine Tune slider is a more subtle tool than the Spill Sponge. Additionally it is not a “one-click” 
tool meaning the user can sample several areas of the image to achieve the most desirable result.   

Also unlike the spill sponge the Fine Tune slider has both a positive and negative aspect. Slide the tool 
to the right to replace spill. Slide it to the left to return some spill. This can be useful if an image has 
been over corrected. 

The spill sponge is a “one-click” tool. Clicking again 
in the same area will not modify the initial 
correction.  

Clicking in a particular color region cleans all other 
similar color regions with spill. Remember you are 
working with color regions as opposed to exact 
physical areas of an image.  Therefore click in each 
color region with spill such as dark hair, light hair, 
dark skin, light skin etc. 
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To use the Fine Tune slider: 

1. Change to one of the two Keyed Image views if not already there 

2. Select the Fine Tune tool from the Chroma Key tool bar 

3. The Fine Tune Sliders appear. Note the sliders are not active until a color has been sampled 
We will only be working with the L-poly (spill) slider 

4. Click in an area of the image with spill. Notice a color swatch appears adjacent to the Fine 
Tune Sliders. Use this swatch to confirm the sampled color is indeed a sample of color region 
containing green spill. 

5. Move the L-poly (spill) slider to the right while examining either the image or the color 
swatch. 

6. Release the slider when the desired result is achieved. Usually only a small slide is needed to 
see a spill correction.   

7. Click Apply to accept the correction or Reset to remove the correction.  

 

 

 

If the result from using the Fine Tune slider is too strong then either: 

• Use the undo feature (Ctrl-z) to go back and try again this time sliding the control less 
distance than before 

• Drag the slider to the left to add back some spill 

A more desirable result is often achieved by making small adjustments in incremental steps rather 
than trying to correct all spill in one action. (Recall, unlike the Spill Sponge, the Fine Tune tool is a 
cumulative control). 

• Sample areas of little spill first, working up to areas of heavier spill 

• Only drag the slider until the complement color just becomes visible in the color swatch. 
Then release the slider and observe the result.  

• Repeat as necessary to achieve the desired result 
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The Spill Minus tool 

The Spill Minus tool (also referred to as the Spill (-) tool) together with its Spill Plus equivalent ( Spill 
(+) ) are possibly the tools of choice for dealing with spill. The tools are both incremental and 
repeatable  

• Repeatable – unlike the spill sponge, the Spill (-) tool allows you to sample the same area 
repeatedly if needed 

• Incremental – several regions of color spill can be sampled with each having only an 
incremental effect on spill replacement 

• Subtle – the Spill (-) tool makes only very small corrections. Several clicks with the 
mouse may be needed before a change is noticed. This allows for greater control with less 
likelihood of over correction 

To use the Spill (-) tool: 

1. Change to one of the two Keyed Image views if not already there 

2. Select the Spill (-) tool from the Chroma Key toolbar 

3. Click in areas of the image showing spill. Several clicks may be needed to see a result.  

4. If needed, sample other areas until the desired result is achieved 

If the result from using the Spill (-) tool is too strong and the spill is over corrected then either: 

• Use the undo feature (Ctrl-z) to go back to an appropriate point and try again perhaps 
sampling a different area 

• Use the Spill (+) tool to add back some spill 

 

 

 

The Spill (-) tool is the most sensitive and 
flexible of the spill replacement tools. 

The subtle nature of its action reduces the 
likelihood of over correction while the interactive 
method of working with the image allows the user 
to sample several areas incrementally in order to 
achieve the best possible result 
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The different spill replacement modes 

As mentioned previously the default mode for spill replacement is to use the complement of the spill 
color.  However two other spill replacement modes are available; sold color and defocus background.  

 The different modes are selected by clicking the Spill Replacement button on the toolbar 

 

 

Complement replacement mode 

The default spill replacement mode uses the complement of the selected background color as the 
basis for spill replacement. For green screen images this means magenta tones are used. 

The complement mode is the method of choice for regions of transparency color spill often found in 
the edges of hair in portrait photography. However this mode may not be suitable when significant 
spill occurs in the foreground proper as can occur with solid spill. 

Solid color replacement mode 

The solid color mode for spill replacement makes use of a user definable color as the basis for spill 
replacement. This mode is most suited to regions of color spill in the foreground itself as can occur 
with solid spill. 

To select the desired color 

1. Click the Spill Replacement button on the Chroma Key toolbar 

2. Select “Pick solid color …” from the drop down list 

3. Color sliders appear. Use them to select desired hue, intensity and saturation of the 
replacement color. 

4. Alternatively (and perhaps more appropriately) click inside the image to choose a replacement 
color. Note the color sliders update to reflect the region sampled. 

5. As a color is selected (either with the sliders or by sampling) the spill replacement mode is 
automatically updated to reflect the selection.  You should notice a change in the image. 

6. Click Apply to accept the result 

 

 

The color sliders can be used to choose the 
appropriate color for spill replacement. More 
often however, the user will simply choose the 
desired color by sampling inside the image in 
which case the sliders will reflect the selection 
made. 

Each of the Spill Replacement tools described 
earlier will use one of three modes as the basis 
for determining the most appropriate spill 
replacement color – solid color, complement or 
defocus. 
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Defocus color replacement mode 

This method uses a defocused copy of the background as the basis for the spill replacement color. It is 
most useful for translucent or transparent foregrounds such as glass. 

To use the Defocus color replacement mode simply: 

1. Click the Spill Replacement button on the Chroma Key toolbar 

2. Select Defocus from the drop down list 

3. The image will change to reflect the new spill replacement mode 

The results achieved with this spill replacement mode will obviously be affected by the current 
background. When a new background has not yet been set the software will use the “transparent” 
background (white with grey cross hatch pattern) 

Becoming familiar with the different spill replacement modes 

In most cases it is recommended the spill replacement mode be left in the default mode – 
complement. There is no harm however in switching to one or both of the other modes and observing 
the result. Remember the spill replacement, although visible in “real time” is not applied until the 
Apply button is clicked. 

The other Chroma Key Module tools 

The tools discussed thus far are the most useful and often used tools in green screen portrait 
photography. However the Chroma Key Module includes several other tools that may be useful in 
some circumstances. 

Matte Sponge 

The Matte Sponge works on partially transparent color regions, using the current spill replacement 
color to make these regions totally opaque. 

Make Foreground Transparent 

The Make FG Transparent tool works in the opposite manner to the Matte Sponge. It makes color 
regions partially transparent. 

Restore Detail 

The Restore Detail tool is used to restore fine detail that may have been lost in the keying process. It is 
used in the completely transparent background regions making these regions partially transparent 
thereby enabling fine foreground detail to become visible 

 

Each of the three tools mentioned above have equivalent Fine Tune sliders and incremental 
Plus/Minus tools 
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Working with multiple images 

The Timestone Software Chroma Key Module offers various methods for working with multiple 
images. The user is encouraged to explore each of the workflow solutions below to determine which 
method or methods works best for them. 

Select multiple images 

It is possible to select several images and key them all together. Use standard selection methods such 
as: 

• Ctrl-A to select all images 

• Ctrl-click to select individual images 

• Shift-click to select a range of images. 

Once images have been selected continue to key the images as described in the proceeding pages. 

Whereas this method has merit in some circumstances it may result in sluggish performance when a 
large number of images are selected. 

Key one image and apply to many 

Once an image has been keyed, the results can be applied to other images. From the toolbar select the 
“Apply to …” arrow (located next to the Detail + tool) then either: 

Apply to next - to apply the result to the next image 

Apply to rest - to apply the result to all subsequent images in the images pane 

Apply to all - to apply the result to all images in the images pane 

Apply to new - to apply the result to new images as they are imported 

 

 

 

When using the Apply to feature it is important 
to understand the keying result will only be 
applied to the currently filtered images.  

For example, let’s say you have multiple poses per 
subject and have filtered for Pose 1. Using the 
Apply to all feature will key only the Pose 1 
images.  
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Copy and paste 

A very flexible approach is to copy the chroma key profile from one image to another.  

To copy the chroma key profile from an image either: 

• Ctrl-click inside the image 

• Select Edit>Copy from the main menu 

• Use Ctrl-Ins as a keyboard shortcut 

To paste the chroma key profile to another image or images either: 

• Shift-click inside the image 

• Select Edit>Paste from the main menu 

• Use Shift-Ins as a keyboard shortcut 
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Setting the background 
There are several methods you can use to set a new background behind the images. Choose the best 
one for your situation 

• Adding a new background directly to the images while in Images Mode 

• Reading the new background image from the data 

• Setting  the new background image when you import a text file 

• Placing the new background directly on a template 

• Calling the new background onto a template via a labeled image 

The first three methods place the new background behind the images themselves. You will see the 
images with their new background in Images Mode. Whenever you use an image the new background 
will be used along with it. 

The last two methods place the background onto the template. The images themselves, although 
keyed, do not have a background associated with them. 

Which method is best for me? 

That’s up to you! Each method has its advantages.  

The template based approach means you will need separate templates for your chroma key work. 
This may or may not be an issue for you.  This approach does mean the images themselves are not 
committed to a particular background. Once keyed the same image could be used in many different 
templates each with a different background. (Note even when a new background has been placed 
directly behind the images, the background may still be turned off and the image may be used, keyed 
without a background.) 

Many users will prefer the power and automation of importing the new background via a text file, or 
reading the new background from data in a field, while the flexibility of manually adding the 
background to the images will also appeal to some. 
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Placing the new background directly onto the template 

In many respects this is the easiest method since you do not do anything to the images once keyed 
nor do you have any special data requirements. Simple key the images then use them on your 
templates. But it does have a couple of drawbacks 

• You need separate templates for your chroma key jobs 

• If offering several different backgrounds you will need a different template for each 
background 

Method 

1. Start a new template  

2. Using the “Add graphic” tool place a graphic holder onto the template.  

3. Browse to and select your new background image 

4. Position and size the graphic as needed 

5. Place the image hole (and any other template objects) directly onto the graphic 

6. Save the template and use it in the normal manner. 

 

A template under construction. 

  

The new, blue, background has 
been placed onto the template 
canvas and an image hole placed 
directly over the graphic. 

 

(The screen gab show the image 
hole moved to one side to reveal 
the blue graphic beneath) 
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Calling the background onto a template via a labeled image holder 

This method is similar to the one above as it does require specific templates however the templates 
are generic in the sense that they can be used with different backgrounds for the same job since the 
background is called onto the template via data. 

Step 1: Designing the template 

1. Start a new template 

2. Using the Add Labeled Image tool place a labeled image hole to the template 

3. When prompted enter @fieldname where fieldname is the name of the field containing the 
new background image. The fieldname can be anything but for this exercise let’s call it 
“Background”. The label is therefore @background 

4. Position and size the labeled image holder as needed 

5. Place the image hole and any other template objects onto the template 

6. Save the template and use it in the normal manner 

 

Here the new background graphic 
is not placed directly onto the 
template and a labeled image 
holder has been used instead, The 
image hole will then be placed 
directly over the labeled image 
holder. 

Labeled image holes are used to 
call graphics onto a layout 
according to a field in the 
software. In this example the 
layout will use the graphic as 
specified in a field called 
“Background” 
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Step 2: Organizing the data 

To make use of the template created in step 1 the data can be prepared in a couple of ways.  

The first method involves importing the new background graphic directly into our field. Recall our 
template created in step 1 had the label @background. The procedure is therefore: 

1. Define a new folder or file field. Call it Background and make sure it is a “graphic” type field 

2. Go to that field. Double-click its value and import the desired background graphic 

3. If importing into a folder field, repeat for each folder 

This approach means the new background is global – either for the entire job via a file field or for each 
folder via the folder field. What if we want the new background to be subject specific and still make 
use of the background template we created in step 1? 

Let’s consider a job where you are offering three different backgrounds. They are: 

• marble.png 

• grey.png 

• swirl.png 

We can proceed as follows 

1. Define a subject field. Call it Background and leave it as a “text” type field. 

2. For each subject enter the appropriate background as a text value 

Obviously entering data manually is not an option for most jobs therefore such data would normally 
be entered by importing a text file or scanning a barcode. 

Dropping the png extension 

We can avoid having to enter the file extension (.png in our example) provided we make the extension 
part of the label on our template. So in the example above our label would become 
@background.png and the value in our field simply marble, grey or swirl. 

Where do the graphics files need to be saved? 

The new background files can be saved anywhere the software normally looks for graphics files. These 
locations include: 

• As specified in File>Options>Paths>Graphics 

• In the jobname#images folder if one exists 

• In the same location as the subject images 
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Specifying the new background when importing a text file 

When importing a text file it is possible to import the subject images at the same time (See knowledge 
base article “Importing Images via a text file” ) When doing so it is also possible to set the new 
background for each subject or image.  

Step 1 – The text file 

The text file simply needs a field with the name of the new background. Here’s a simple example.  

John, Smith,2222,100.jpg,marble.png 

Alan,Martin,3333,101.jpg,grey.png 

The fields are firstname, lastname, ID, image filename and background filename respectively. 

Step 2 – Importing the text file, mapping the field 

Making use of the above text file is just a matter of mapping the “Set background” field.  

1. Enter the import text file setup window (Details Mode>Subjects>Import text file>Setup) 

2. Map all fields as per usual 

3. Check the “Set background” option. This presents an additional field to map 

4. Map the background field and import the text file as usual 
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Step 3 – Placing the new background for each image 

When setting the new backgrounds in this way they will appear as soon as the images have been 
keyed. No further steps are required 

Reading the new background from data in a subject field 

This is similar to the “Labeled image” method described above but now instead of a labeled image 
holder on a template reading the value of a subject field, the user selects the field with the 
background data from within the Images Mode itself. 

Step 1 – Organizing the data 

Let’s say we have a subject field called “Background” and it’s a text type field.  Remember the field can 
be called anything you like; it does need to be called “Background” We enter the name of the new 
background into this field. Use whatever method you currently use to input data. These include: 

• Importing a text file 

• Keyboard entry 

• The /%D barcode 

Continuing the example from above we could simply enter the values, marble, grey or swirl into the 
field called background, 

Step 2 – Point the images to the “Background” field 

Once the data is in the field it is necessary to tell the images which field. 

1. Select the images 

2. Go to Images>Background>Set from field … or use the Ctrl-Alt-K keyboard shortcut 

3. A pop-up window appears allowing you to select the field with the background data 

The new backgrounds will be imported and placed behind the images. If a large number of images are 
selected this may take some time. Note you may set the new backgrounds before or after keying the 
images, it makes no difference. 

Setting the new background directly to the images 

The new background can be set directly to the images while in Images Mode irrespective of any data. 

1. Select the image or images 

2. Go to Images>Background>Set …or use the Ctrl-K keyboard shortcut 

3. A pop-up window appears allowing you to browse to the background files 
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Turning backgrounds on and off 

Once a new background has been set, it is on by default. The new background will be used whenever 
the image is used. Backgrounds may also be turned off. When turned off the background is 
transparent  

1. To turn off the new background go to Images>Background>Off or use the Shift-Alt-K keyboard 
shortcut 

2. To turn on the background go to Images>Background>On or use the Shift-Ctrl-K keyboard 
shortcut 

 

 

 

 

 

 
 

 


